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Those of you who have followed my work for a while will know how fond I am of presenting several images together as 
a single piece of work - what we call “Chocolate Bars”. One of the nice aspects of this approach is that it reduces the 
competition between the different elements to be “the best”. The strength of a piece like this lies in its diversity of content 
rather than in the superiority of one image over another: “The woods would be very silent if no birds sang except those 
that sang best,” as Thoreau put it. Moreover, this way of shooting encourages exploration rather than the dispiriting 
pursuit of the perfect photograph. The photographer gathers elements to be conjured into something as yet unknown, 
later.  When I tried to explain all this to my subject, this was the reaction I got. - Niall
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News from Niall and Charlotte

This has been about the longest summer we’ve ever 

had - but it wasn’t spent in Scotland. Summer in 

the east of Scotland - currently home - is characterised 

by the sun smiling on you while the wind holds a 

knife to your ribs. But we were away from all that for 

seven whole weeks - three working in Austria and four 

doing a different sort of work on our house in France. 

We experienced for the first time temperatures in 

excess of 40 ˚ C and found out how hard it is to carry 

on as normal, especially if you’ve cement to mix or 

foundations to dig. But whatever our tribulations, they 

were nothing to those of the livestock farmers round 

us, all of whose fields where parched to a Sahel white 

in the blistering sun. Many had had to start feed their 

cattle with hay cut just weeks before - stores set aside 

to see the beasts through the winter. Times like this 

make you wonder if relocation to the Mainland is a 

wise move - until you return home and feel that knife at 

your ribs again.

Since coming home, there has been a bit of a flurry of 

commissioned work with Niall’s usual Scottish Tree of 

the Year job (see one of the six trees, left, below) for the 

Woodland Trust and a sizeable new commission from 

the government agency, Forestry and Land, Scotland, to 

produce a range of identification images for a variety 

of tree species. In addition to keeping the office under 

control, Charlotte continues to create more dishes 

to roll out on our Retreats this autumn in Burgundy, 

Torridon and Islay as well as entertaining a delightful 

round of visiting family and friends.

This has been Niall’s most productive summer for many 

years when it comes to producing field studio images 

(this mantid was in our garden in France). If you don’t 

do so already, you can follow him on Instagram to see

what you can do with a couple of Cactus flashguns

and two pieces of plastic!

With best wishes

Niall and Charlotte

Directors.



How our possessions mock us. Recently, I decided 

to address a long-standing domestic issue: closet-

fill. More specifically, the time had come to empty 

cupboards of old laptops, drives, a scanner and CRT 

display, SCSI cables and other redundant technology. 

As I rendered each unusable, I reflected ruefully on the 

emotional investment I had had in these objects I was 

now destroying. In their day, 

any crash or unfathomable 

failure to respond 

caused despair 

and more 

often than not, unwanted expenditure. About the same 

time in this clear out, I came across an extra copy of a 

book I produced in 2004 for Aurum Press and the NTS 

called Scotland’s Wildlife. It was an illustrated series of 

essays about our relationship with the land in Scotland 

dressed as profiles of  70 or so species with a Scottish 

story. The photography was very pictorial and didn’t 

reflect the routes my work has since taken but the book 

was nevertheless something concrete to show for my 

career up until then. I didn’t throw it out.

Advertisers (who, you could say, are cynics who persuade 

the gullible to buy things they don’t need with money 

they don’t have) tell  us that we can express ourselves 

through the  things we buy. I believe that this 

is self-serving nonsense: owning something 

that someone  else  has designed and 

manufactured merely casts us as consumers, 

expresses only our access to cash. True self-

expression originates internally, then finds 

its way out into the world; it is not something 

that can be assumed or appropriated. You 

and I are fortunate that we do something 

with great potential for self-expression; we 

create photographs reflecting what matters 

Idea - The beauty of 
books

Sea eagle, Sør Trondelag, Norway
The publication of this image in 
my first book had some interesting 
consequences. Ask me sometime!
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to us. And I believe there is no better way of sending 

our photographs out there than between a pair of hard 

covers. This is how you put down your marker and say, 

“this is me.” This is what defines us and what endures - 

not the things we buy.

While novels may work better on a tablet than as hard 

copy, when it comes to books of fine photography the 

electronic version can’t compete with a well-produced 

print version (not least because of our ludicrous 

infatuation with looking at things on the tiny screens of 

our ‘phones). E-books have been no more successful at 

killing off beautiful photography books than iTunes has 

been at killing off vinyl, although Amazon plays a large 

role these days in determining what is commissioned 

by the traditional publishing houses. Indeed, without a 

celebrity endorsement, a TV tie-in, massive social media 

interest or completely anodyne content, mainstream 

publishers are scarcely worth pitching to these days. 

Fortunately good alternative routes to publication exist.

Self-publishing used to be a by-word for an unusually 

expensive   form  of  narcissism. But  that has changed in 

two regards; funding, and a recognition  of the need to 

use  professional production expertise and designers.

Colleagues, Matt Maran (Hampstead Heath: London’s 

Countryside) and  Neil  McIntyre  (The Red  Squirrel: a 

Future in the Forest) have run successful Kickstarter 

campaigns to fund the independent production of two 

fine books with high production values. The nice thing 

about the Kickstarter model is not only does it alleviate 

the cash flow shortfall that can drown a project at 

birth but that it also tests its viability. There’s no market 

research quite as “real world” as putting a pitch online 

and seeing if people pre-order the book. If it doesn’t work 

here, no amount of hoping and faith  is going to make it 

work through “normal” publishing channels.

Funding  aside,  self-published  books  need  the 

involvement of a professional project and production 

manager who sees to everything from appointing a 

designer, choosing and sourcing the best paper stock for 

the project, hiring the printer and a whole host of other 

skills few photographers new to publishing, posses. I put 

Matt in touch with one of the best in the business, David 

Brimble who, amongst other projects, was production 

manager for five recent Wildlife Photographer of the 

Year books and who I’d commissioned to produce some 

costs for me the year before. David turned Matt’s great 

idea and set of images into a book that is light years 

away from the vanity publishing of the past.

These sorts of projects really put your work out for all to 

see. Whatever else Matt and Neil do in their careers, they 

have each created something rather fine and specific 

to them; they have put down their markers. Even if your 

ambition  doesn’t involve putting your book into the 

hands of “the public”, I believe that books produced for 

your own circle of family and friends - or even just for 

yourself - have immense value. If nothing else, the images 

are more readily accessible than on a hard drive  (that you 

will be undoubtedly throwing away one day). When Iona 

and I made her first Blurb book in Lightroom I was more 

impressed at the quality of production than I’d dared 

to expect. While  it may not have the same production 

values as these other examples, the project was realised. 

And that’s always a good starting off point for the next, 

more ambitious one.
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Skill - Colouring backgrounds
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I f you find the pure white background of a field studio image a little too stark, it’s not 

so hard to change it, so long as none of the subject is blown out too. And it’s the fact 

that you’ve gone to the trouble of ensuring that all the background, in each channel, 

is 255 that makes the job easy with the Color Range selection method in Photoshop.

There are a couple of caveats. You will always find highly out-of-focus edges hard 

to select convincingly. In the case of field studio pictures, a blending of the subject’s 

colour with the pure white background tests the limits of the selection algorithm. So, 

I prefer to work with images in which all parts of the subject are in-focus, sometimes 

backing off to reduce magnification when I make the photograph to gain depth of 

field then cropping in later. Secondly, pale replacement backgrounds generally work 

better than dark ones as it is much easier to overlook any legacy white pixels around 

the edge of the subject.

In Photoshop, go to Select>Color Range>Select Sampled Colors and Fuzziness 0. 

Fuzziness defines how different a pixel can be from the one you selected (in this case, 

from the background) to be included in the selection. If your background is all pure 

white, a 0 setting should allow it all to be selected. If there are any areas that aren’t 

(with the Selection preview button clicked, they show as black) simply click on them 

with the sampler tool, while holding down the Shift key, until they are all selected. 

Now only the subject should be showing as black - unselected. Hit OK then return to 

Select, only this time go to Modify>Expand and set to 1 pixel. This moves the selection 

very slightly toward the subject, getting rid of stray white pixels around its edge.. With 

the selection live, go to Edit>Fill>Color and chose what you want for the background. 



Food - Leek and
stuffing plaited pie
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This vegetarian recipe takes a while to prepare, so give yourself 

time so you can enjoy making all the different components. 

Put on your apron, select your playlist, get a drink, set out all your 

ingredients then create this delicious dish. I’d suggest you serve it 

with a crunchy green salad, some small sweet cherry tomatoes for a 

splash of colour and baby potatoes. You can roast these in their skins 

in olive oil with a seasoning of salt and pepper and a sprinkling of 

freshly chopped thyme.

Ingredients

serves six

3 long leeks, washed and cut into rings roughly 15mm wide

2 tbsp of olive oil and a small knob of butter

1 tbsp of Dijon mustard

4 tbsp of grated mature cheddar cheese

1 egg, beaten to glaze the pie before baking

Nigella seeds for the final garnish before baking (you can find them 

in the spices and dried herbs section in a supermarket).

Stuffing mix

1 large onion, finely chopped

1 tbsp of olive oil plus a small knob of butter

1 tbsp of fresh sage, finely chopped

80g of fresh brown bread crumbs

1 small apple, grated

100g of cooked peeled chestnuts, finely chopped

1 egg, beaten

2 tbsp creme fraiche

Sea salt and freshly ground black pepper.

Photography note: With my studio space currently full of the 40-odd boxes we take on Retreat, I retreated to a corner of Charlotte’s kitchen to arrange 
my set. The ambient light there isn’t great so out came the flash - but not my usual one. Encouraged by the look I’ve been achieving recently with 
my Cactus flashes, I set aside the Elinchrom, grids, flags and all the other paraphenalia in favour of a striped-down approach. I fired a single radio-
controlled Cactus flash, an inch above the floor, through an A3 piece of Flyweight diffuser for this mellow-yet-moody look.



“Here’s a lovely thought: gathering 
golden chanterelles while ambling 
through the dark, humid woods then 
taking the basket back to your cool 
kitchen. There, you will cook the 
mushrooms with fresh garlic, butter and 
shallots then sit down to enjoy them with 
hot crusty bread and some chilled white 
wine. Welcome to France.” - Charlotte

Pastry

Use either a roll of bought puff pastry or make your own herb 

shortcrust pastry. Here’s the recipe.

300g of plain flour

110g of cold, unsalted butter cut into small cubes

A pinch of salt

2 level tsp of fresh thyme, finely chopped

1 egg, beaten and mixed with 2 tbsp cold water.

Method

If you are making shortcrust pastry, do so first so that it can chill in 

the fridge.

 

[Put the flour, butter and salt into a food processor and pulse these 

ingredients until they resemble fine bread crumbs. Add the chopped 

thyme and briefly pulse so all is mixed together evenly. Add the egg 

mix a little at a time until the pastry is just starting to bind. Remove 

it from the mixer and briefly knead the mix together to form a ball 

of pastry. Be careful not to overwork it. Wrap it in baking paper and 

place in the fridge to chill for 20 - 30 minutes.]

1. The stuffing mix. Preheat the oven to 180° /160° fan / Gas Mark 4

Set a shallow, lightly greased baking dish/tin to one side.

2. Heat the oil and butter in a large frying pan over a gentle heat 

and add the chopped onions. Gently sauté them until soft and 

translucent. Add the grated apple, sage and chestnuts then season 

with a good pinch of sea salt and some ground black pepper. Stir 

well and continue to cook gently for a further five minutes. Remove 

from the heat and add the bread crumbs, stir well and then mix in 

the egg and creme fraiche. 

3. Tip the stuffing mix into the greased dish/tin and spread it out 

evenly. Once the oven is up to temperature bake for about 20 minutes 

until it is slightly crispy on top. Remove from the oven and set aside 

to cool. You can leave the oven on for baking the pie at the same 

temperature.

4. Preparing the leeks. The pie cuts easier if the leek pieces are disc- 

shape, rather than sliced lengthwise. Take a large frying pan (it really 

is fine to use the pan you made the stuffing in without washing it 

first). Add the olive oil and butter and once the pan is heated, add 

the leeks and gently sauté for 15-20 minutes until they are soft but 

still retain their shape. Season with a little salt, pepper and thyme 

and set aside.

5. Now all the individual components are prepared, you can 

assemble the pie. Take the pastry from the fridge and roll it out on 

a floured work surface to create a rectangle roughly 300 x 400mm. 

Transfer it onto a sheet of baking paper. (A little tip: fold the pastry in 

half from the top, then loosely quarter fold, lift it onto the paper, then 

unfold.) Score (don’t cut) the pastry to make three equal rectangles, 

the length of the pastry. Then, with a small sharp knife, cut the pastry 

horizontally at about 15mm intervals down either side to leave the 

central rectangle untouched. See the photo, right.

 

7. Place the stuffing mix down the central rectangle area and spread 

it evenly, then lay the leeks evenly on top.  Freeze any extra. Next, dot 

the mustard evenly over the length of the mix using two teaspoons. 

Sprinkle the cheese over it and then start to make the plait. Begin at 

the top by folding over one of the top pastry lengths to the middle 

and then fold the corresponding one over to slightly overlap it. Keep 
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doing this until you get to the end of the pastry. Tuck the final two 

strips into the base of the plaited pie to seal it. Gently lift your 

creation onto a baking tray then brush it with the beaten egg and 

sprinkle it with the Nigella seeds. Bake in the pre-heated oven for 

about 30-35 minutess until golden brown. Remove from the oven and 

leave to cool a little before serving. 

Now, what happened to that first drink?

- Charlotte

 



Featured Retrewat - 
Rural Burgundy
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AN early summer creative outdoor 

PHOTOGRAPHY RETREAT IN rural france 

25th may - 1st june, 2020
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experience in 2020. Spring was late in 2019 so, just to 

be on the safe side, we are running this next one a 

month later to ensure that the forests are leafing out 

and there is more insect life. Once again we will use the 

lovely converted stable block adjacent to the Château 

de Magny en Morvan, near Millay, as our base from 

which to explore the woods and fields, ponds and hills 

of the surrounding countryside.

In addition to Charlotte providing great food and a 

nice ambiance for discussions, Niall will help you to get 

to grips with creating:

•  Colour Transects; 

• “Chocolate bar” collages;

• Field studio photography.

That makes for a pretty full programme! We have gone 

on to using the Cactus flash system for field studio work 

which has shown itself to be more than an equal of the 

much heavier and more expensive Elinchrom system 

I was using for this work before. We will help you to 

master it too - or which ever one you already own.

Guests have commented before about how this part 

of Burgundy feels “authentic”, largely untouched by 

tourists and with a take-us-as-you-find-us attitude. 

We ran our first spring Burgundy Retreat in April 

this year in conjunction with our German friend 

and colleague, Willi Rolfes, welcoming nine guests 

from the US, UK, Austria, Germany and Switzerland. The 

feedback suggested it was a great success but being 

us, we came up with a number of refinements, including 

two-tier teaching, Photoshop templates and no before-

breakfast tutorials (!) to make for an even better

They have loved the feeling of being removed from 

everything that’s happening in the outside world. It’s 

perhaps something we all need at the moment.

Our house is just 25 minutes from the Château so we 

know the area well and can take you to favourite 

corners and give you the time you need to get beneath 

the skin of the place.

Read all about the Retreat in our brochure which you 

can download here.

https://www.cactus-image.com/products.html
https://static1.squarespace.com/static/5ac245923917ee7c2c0ebdc4/t/5d1f3452d7cf6b000129f668/1562326149060/Burgundy+Retreat+May+2020.pdf


Dates - our Retreats in 2019 and 2020. Full details on our websi te. 
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HARRIS, 
SCOTLAND

15 - 22 February, 2020

BURGUNDY, 
FRANCE

25 May - 1 June 2020
27 September - 4 October, 2020

THE TYROL,
AUSTRIA

12 - 19 June, 2020

ISLAY AND JURA,
SCOTLAND

17 - 24 November, 2019 (Full)
14 - 21 November, 2020

TORRIDON,
SCOTLAND

2 - 9 November, 2019

2021 dates, with new 
destinations,coming soon

https://www.foodandphotographyretreats.com/
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Inspiration - James Balog

Throughout his forty year career, Jim Balog has 

distinguished himself as an innovator with a 

deep curiosity about the nature/culture dynamic, 

expressed in a diverse body of work that ranges from 

experimental art photography to incisive documentary. 

The pictures shown here are from his “Changing Forests” 

collection created between 1998 and 2004 in which he 

sought out the United States’ most distinguished - by 

their height, age, spread - trees. He deployed a number 

of techniques to help us understand their scale, from 

Hockney-esque montages to vast white backdrops 

suspended behind the subject. His portrait of the giant 

sequoia known as Stagg (right) - the largest known 

living tree on Earth - was the first to allow viewers to 

grasp the true height of giant trees like this, not from 

the ground looking up but in parallel with the trunk. 

Red jacketed climbers give the impression of scale. The 

techniques he pioneered on this project laid the ground 

for Michael Nicholl’s celebrated redwood portrait 

almost a decade later.

Since 2007, Balog and his team’s Extreme Ice Survey 

has provided irrefutable evidence of the loss of ice 

in glaciers from Antarctica to Greenland, and Alaska 

to Austria using dozens of time lapse camera left to 

operate over months and years, recording the changes 

in calving and ice cover. This mammoth undertaking 

culminated in an Emmy Award-winning film, Chasing 

Ice, which has since been seen around the world and 

has played an important role in the shift in public 

understanding around the issue of climate heating and 

why distant, melting glaciers will have consequences 

for us all.

Photographs © James Balog.

https://www.thisiscolossal.com/2010/10/the-first-ever-seamless-photograph-of-an-entire-redwood-tree/
http://extremeicesurvey.org/about-eis/
https://chasingice.com/
https://chasingice.com/
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Bonus footage - Rhododendron leaves

There is, perhaps, an element of surprise in this piece - that 

Rhododendron leaves can be something other than sombre green. 

But even evergreens need to shed their leaves sometime and replace 

them with fresh ones. Rhododendron ponticum doesn’t make a big 

fuss about this process but from August onwards you can find some 

beautifully coloured leaves in the depths of the shrubbery.

The idea for this image came directly from a very similar one of 28 

Eucalyptus leaves created by Meet Your Neighbours photographer, Lily 

Kumpe, a few years ago. Each element was shot separately in the field 

studio then scaled as a Smart Object and composited in Photoshop. 

With autumn just round the corner, maybe it’s time to try this with some 

more obviously colourful autumn leaves such as oaks and maples. This is 

work we routinely do with guests on our autumn Retreats.

MENU is published bimonthly. The next issue, No. 9, is out on 16th 
November 2019. Words in turquoise are linked to external web pages.
All content is copyright of Niall and Charlotte Benvie, 2019, unless 
otherwise stated. Food and Photography Retreats Ltd., Wardhill, 
Brechin, Angus DD9 7PE, Scotland. 
office@foodandphotographyretreats.com +44 7400 303 930. 
Company registered in Scotland, SC596219.

https://www.facebook.com/meetyourneighbours/
https://www.lilykumpe.com/
https://www.lilykumpe.com/

